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Software Overview

Hop! Study software helps students do their schoolwork and play an active role in achieving success.
This User’s Guide will lead you to discover tools created to help you manage your time, structure your work,
and organize your knowledge. Let's start with a general look at how the software is structured.

Hop! Study
Planner Workspace
To efficiently manage all To work on your projects.
your projects.
2 ways to enter work on the planner 3 environments are available
wa
| —
/ /
Work on... .
Plan general work Work Management ) Testing
on a subject. Find out what you need to do ‘ Quiz yourselfjon tEe
- . information stored in the
V and think about your project. Content Pages.
New Project V
Add a project. Content Pages
Enter data and process
information.
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Create a New Document

Two choices are offered when creating a new document: create a blank document (a knowledge base) or
create a document from a template (a project). Hop! Study offers eleven types of projects. Each project

contains a list of tasks to complete and templates to help you organize your data.

Note that you must open your planner first if you want to integrate the project info your schedule.

Create a New Document

| % Create a project
| from a template

- Create a
blank document

Start Date

12008/3/14 \
Due Date

2008/3/15

Preparing for an exam
Memorizing a text
Oral Presentation
Research

Marrative Summary
Informative Summany
Essay

'Writing a story

Other Composition
Experimental Method

Other Project

| Cancel |

You can change the
suggested dates.

If the project you want to work on is not listed, choose
the template Other Project or click on Create a blank

project.

NOTE: Other Project contains a list of various tasks,
whereas a blank project is empty.

Each type of project is linked to

forms and templates created

specifically for that kind of work.
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Content Pages - Index and Navigation

In the Content Pages environment, you can create and save all the material you use throughout your project.
The index is organized into two levels to help you manage your knowledge and process data. The first level
lists only other indexes, whereas the second level indexes are used to classify Content Pages.

Use the "A" tool
to modify the name

To delete or duplicate
a page, first select it

(reate a Move a selected page
new index. to another index.

To quickly create blank pages:
diagram, card, linear organizer
and Question & Answer.

/ using the "Arrow" Iool/ of an index.

[
Open the
Index Panel. @ Cats
J/ ‘ B Abyssinian Friday, April 13,2007 O -
& cars Friday, April 13,2007 O i
A It ()
Boam (@ Domesticated varieties Friday, April 13, 2007 O @j
e Gifts Friday, April 13, 2007 O <
[===2]
=2 Important dates Friday, April 13, 2007 O
e Shorthair Friday, April 13,2007 O
(Elears . :
it Sphynx Friday, April 13,2007 O
“"' i Turkish Angora Friday, April 13, 2007 O
[El stmorthai
hllun:

Double-click a page

Go back fo the

previous index.

To open the dialog box "Add a page"

and choose a template.
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Content Pages - Add a Page

Hop! Study offers four types of pages to organize your information: cards, diagrams, linear organizers, and Question-and-Answer cards.
In addition fo these four blank pages, Hop! Study contains numerous page templates from which to choose. This allows you to display
data in many different ways, as well as collect large amounts of information within the same document.

NOTE: To add a new page, you must be in the Content Pages environment.

Add a page

Duplicate a page with
all its contents. \

\Q,'.'I Duplicate a [ Finding a Topic - Brainstorm £
recent page : =
Eusy access 1‘0 a @lel"ﬁl‘lﬂ Ut & Project
previously used <€<—— @ Choose from @Fﬂlsenmlnn Overview
Iemplule. e @Hﬂeu:h OWerview
Choose from templates
ﬁ related to this project @studv Content Overview

Display a list of g ;
templates specific to <<—— ﬁ Choose from the [ Topic Exploration
the current project. template list 2] Topic Summary

/@ Choose a n"""'*e'""

blank page =
Display the complete & B8 abe of
template ist. ] B | o
l [ Thearem -
Choose a blank page from the list. A different template list
* is displayed depending

on the button you select.

[l care

Eﬂ:}]mesﬂun & Answer
nla.gl'am
@Hl:mrlc Timeline
@Nu merical Scale
[gs:egmented Timeline
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Content Pages - Using Templates

There are approximately 70 templates to help you study better and learn more efficient work methods. Among them you will find
cards, diagrams, and linear organizers containing various objects ready for you to enter content. Pages created from
these templates can be fully customized: all objects can be modified, moved, deleted, and renamed.

Some pages contain instructions. All other elements on the page (boxes, You can also add
This text cannot be modified, but connectors, fields, titles, field names, etc.) or delete objects.
it can be deleted if necessary. can be modified, including their size,

position, color, and texl

|I|':".I'I o Wl D Talf T T 10 /
Presentation

| Dv!ru'n!w

Ainteresting

v

The shaded text indicates what kind of content you
should enter in this object. The instructions
disappear once you click on them to enter text.
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Making Diagrams

Diagrams, outlines, and concept cards are graphic ways to organize information. They are excellent tools to grasp
what you are learning and to connect ideas. Below you will find descriptions of tools that are commonly used
to make diagrams. You can also consult the next page for information on how to change their formatting.

Toolbar menu section
L ' a\f
I/ I/

A

Add a Connector

fo connect.

You can create a freely posifioned
connector on the page or snap it fo
boxes.

Add an Image

Click on the tool, and then drag your
cursor hetween the objects you want

v

\» \

Add a Connected Box Edit Text

A quick way to create boxes and Use the "A" tool fo edit the
connect them. content of an object.

A connector is automatically created
between the new box and the box
that was previously selected.

Opens a dialog box to import an image.

If a box is already selected, the image will be imported

Add a Box
Click on the tool, and then click on the page.
Alternately, simply double-click on the page

Select Objects

Use the "Arrow" tool to select the
object itself rather than ifs content.

into that box. Otherwise, a new box will be created.

NOTE: You can also paste an image directly into a box.

I nothing is selected on the page, click on the Paste
button fo create a new image box.

OR

If you are editing an exisfing box, press the TAB key
to display the blank image field, and then dlick on
Paste.

background to create a hox.

Hop! Study - User's Guide
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Changing the Appearance of a Diagram

Since a diagram is a visual way to represent information, it often helps to add meaning to its boxes and connectors
by changing their appearance. The Style Gallery offers many useful formatting options for you to explore.
Note that all the diagrams available in the template list have been created using the Style Gallery.

Diagram Style Panel

Exclude the text in this object from quizzes

Font color <é‘_‘|. in the Testing environment

Futura Conden 5€

i ] @
|

Font size <<—— ﬂ.-i 14 A4 —+—>> Text alignment
Line spacing <€——

|

. @

=
|

—= First line indentation

——=> Spacing before paragraphs

Al IE -

A
Left margin<<—— i = | 0
—g!

o
4 |49 |4

Right margin <<——

Line color @——l__ —>> Line style (first option = no line)
. (MR EER

Fill color <<———

——=> Spacing after paragraphs

S Transparent interior (no fill)

[ A
Image size (unit and value) <=—— L7 |?5
ge size | ) Eﬁu L, =]

Box shape <<—

(1] () O ﬂ—»lncreuseboxsizemuking all its dimensions equal
—
=0

. | ppe— |j — Snap connectors to an image (style selected here),
Image and text position <€— B= = S rather than to the box contour
Set box text as the page fitle <———[ Page Title ]

Dropdown lists with various By defm{h, connector anchor poims are set
optonsfor changing fhe - — \ _Ip. uulon:iut;ulz and follow the objects as these are
appearance of connector - - 7 moved (Fluid connecor).

lines and endpoints Huid Fizond - Alternately, you can snap connectors to fixed anchor

points by choosing Fixed anchors.
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Using Linking Words

Diagrams are used to establish relationships between concepts and ideas. Hop! Study offers an inventory of linking words
to help you organize your thoughts more clearly by specifying the type of connector that joins two information hoxes.

Initial situation

Evant A

Consequence |

Consequence ‘

Event B

You can select a linking word
from the dropdown list.

OR

You can enter your own
linking words.

As a result of
Depends on

Therafore
But

Or
And

That is
In brief

Compared to
Same as
Similar to
Different from

Before
After
First
Maxt
Finally

Except for
Instead of
Contrary to
Similarky

nceg ‘

Hop! Study - User's Guide
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Making Cards

Cards allow you to classify and save important information. They can be used to take reading notes, keep track of references,
review notions learned in class, and more. Below you will find descriptions of tools that are commonly used to make cards.
You can also consult the next page for information on how to change their formatting.

SR %A

Card
Toolbar menu section
Add an Image Field
Inserts a blank image field
info the card.
Add an Image

Opens a dialog box to import an image.
If an image field is already selected, the
image will be imported into that box.
Otherwise, a new field will be created.

NOTE: You can also paste an image by
clicking on the Pasfe button.

Y \

Add a Field Edit Text
Inserts a text field Use the "A" tool to edit the
into the card. content of an object.

V

Select Objects

Use the "Arrow" tool to select the object
itself rather than its content.

Hop! Study - User's Guide
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Changing the Appearance of a Card

Cards should be easy to make quickly and in large quantities, so they need very little formatting in most cases.
However, the Style Gallery contains some formatting options you can use to enhance the functionality
of your cards by adapting them to your needs and context.

Card Style Panel
Font color <€——|— ﬁ_ Exclude the text in this object from quizzes
ont color . Arial w pe- in the Testing environment
Font size <<—1— :‘L‘t 16 - =5 = => Text alignment
= T ——
Line spacing <€—1— — - 0 N = Pu—
a= 10 & — = First line indentation
Left margin <€——— £ = 3 = é 3 o — = Spucing before paragraphs
Right margin <€——— == : 0 - $ 3 @ — = Spacing after paragraphs
e B e O _I:I _@ —1 > Frame, title, and content arrangement
Field position [ = '
(under or beside the title) — T = [] N — >> Change field order
Field height <%——I 0 @ | 580 ——> (ard size

Frame
Vacabulary //:’
<< Title /
Content

7
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Making Linear Organizers

Hop! Study offers four types of linear organizers: a historic timeline for arranging chronological events,
a segmented timeline for arranging sequential stages, and a numerical scale for comparing number values.
Below you will find descriptions of tools that are commonly used to make linear organizers.

Yip L
L] L i
4 | ]
......... I. II =
1 World War 5
o -:
P ol 1 Years
wt 9 | 1]
- Life expeciancy
1 £ ea
L3 Tropee e [] [FE rcalliey idem \
, I ]
Ky ] You can change the
12 | . .
s g measuring unit used
\L T 2 e in a numeric scale.
| Introdacnin Basdy | Coschasion I
You can change the start and e You can change the
. o e o il o oge .
end dates of a historic timeline. = initial and final values
of o numeric scale.

¥

You can change the names of
stages in a segmented fimeline.

Add an Image

Opens a dialog box to import an image.

If an item is already selected, the image
will be imported into that item.
Otherwise, a new item will be created.

Add a Segment
Add a stage to the fimeline

You can change the fitle of You can change the size of
any linear organizer. stages in a segmented timeline.

Toolbar menu section

You can change the size of the entire
sequence in any linear organizer.

R WA

> Edit Text
Use the "A" tool to edit

the content of an object.

(only for segmented timelines).

v
Add an ltem

Click on the tool, and then click on the
page fo add an item to the timeline.

\ Select Objects

Use the "Arrow" tool to select the object
itself rather than its content.

ltem name

|——9> [tem name

—t—>> Date or initial value

——=> If the item has a time duration or inferval,
enter the dafe or final value.

If you wish, you may enfer comments
o related information here.

Hop! Study - User's Guide
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Changing the Appearance of a Linear Organizer

You can format items in a linear organizer to complement the meaning of the information they contain.
The Style Gallery contains various formatting options, which are listed below. To change the parameters
of the sequence itself (name, size, scale, interval, etc.), consult the previous page.

198

George Bush
—
LEE9

500 LA

Ranald Reagan
—

George 'W. Bush
——

Using the color of US presidents’
political parties is a great example

of a formatting option that adds
meaning to visual information.

fill Clirton
156 I
;ll.l.l
| p
1 980 2007
Presidents of the United Stabes
Linear organizer Style Panel
Font color <<—— |
—' |Verdana - E —
Font size @—&A 14 4 == =
T ——
Line spacing <€—— ~A 0 o
_J{ = IE |:| v—
el = e
Left margin <€——— === |} < = 0 @
Right margin <€<——— = 0 - $ 0 o
Line color @——"i
Fill color @——1 | | I I I I
E A
"% |Surf 10000  —
Eﬁ‘“ AR | 7

Exclude the text in this object from quizzes
in the Testing environment

——>> Text alignment

= First line indentation

>> Spacing before paragraphs

—=> Spacing after paragraphs

>> Line style (first option = no line)

T Transparent inferior (no fill)

—>> Image size (unit and value)

NOTE: You can also apply line attributes (size, color, fill) to the stages of a segmented timeline.

Hop! Study - User's Guide
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Question-and-Answer Cards

Although these cards can have many applications, they are a valuable tool to study for exams. Formulating questions about your class
notes encourages you to stay actively engaged in reading as you select and rephrase key elements of your study subjects. This way, you
study both when you prepare the cards and when you use them. In addition, you can keep the cards you make for later use, such as
reviewing for final exams. Question-and-Answer cards are usually linked to the Testing environment, which is presented in the next page.

Here is a blank Question-
>> and-Answer card ready for
you to enter data.

Where dad ihe Hlack Death epademsie oooer?

Ia Fisope

Whal & (he nases ol B esallal Sk

Thie Asctie Qecin

NOTE: Most likely, you will be creating a large number of Question-and-Answer cards. Remember that you can use an index
to classify them by chapter, by topic, by week, and so on. This makes them much easier to find and use in the future.
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Testing Environment

The Testing environment allows you to quiz yourself on the information you store in the Confent Pages. Quizzes are not necessarily limited
to Question-and-Answer cards. Any Hop! Study page can be used: one of the fields will be hidden and you will have to provide an answer.
They can also be restricted to a parficular index to reduce the number of possible questions. Finally, don't forget that you can exclude
specific information from the quizzes by checking the appropriate button on the Style Panel.

You can check the
indexes you want <<—
to be quizzed on.

The number of
possible questions is
calculated based on
the index you select.

Enter the number

of questions you @ﬁ% "
want to be asked.

First screen: Parameters

Second screen: Questions

—&f D Chapter 1
Total pages.......: 8
Total questions...: 10

o D Chapter 2
Total pages.......: 3
Total questions...: &

— Total available questions: 16

How many guestions?

Formula G Drcumference of & circke

Caleulation | |

Whetn i T PoaTrada spfiad
The crosmisrerce offa circie mears the length of the crde

e
o lgeerT that Begin from The ctre and
O Lie DerChg

My anversr

Third screen: Feedback

Click OK when you are
ready to start.

Whil & the nar ol Se

allenil eninien ¥

The: Antie Oecis

-EDRREE ALMOST HISSEEIJ

The Rrtic Ocean

i | A
% VY |
Hidden data will be Enter your response, or (lick OK when
outlined in red. answer the question in you have the
your head. answer.
Fourth screen: Results
CORRECT 8/10
| ALMOST 1/10
MISSED 1/10
85 %
Jllll.'lnlluur —
S 7|
i | Frarted - = I:

Compare your answer
to the solution.

\

Click on the adijective that
best describes your response.

¥

(lick OK to start a new test.

Hop! Study - User's Guide
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Work Management - Tasks Tab

The Work Management environment contains three tabs with checklists and forms to fill out. This first tab contains a list of tasks broken
down into project phases. These action plans are different for each type of project. They allow you to divide your work into smaller,
more manageable tasks, making it easier to plan your project over time.

The deadline is displayed
automatically.

A

I
Type of projedt <€<—1— Presentation Due Date

/Presenm:ian title Tuesday, October 23, 2007

Add proiectdeiuils./ | Tasks | | Project Assessment

L1 I fll out the Project tab bo define my assignment.

I use the Presentation Overview diagram to guide my research.

Check off

completed tasks.

011 use the strategies of my choice to gather information. (o2 G2
« | take Motes and keep track of my References while I read.

= | read and visually erganize the information 1 find.
Exploration, Summary, Causes Efects, Procéedurs. Seguence, Cyole, Timeling

/ I use the Interview card to interview an expert.
L—

Click on the blve <& | 01 read the information I collected and check off what [ want to keep. @
links to create
Content Pages.
\y 01 wse 2 Dipggram or & Timeling to outling my presentation.

L1 I prepare supporting material {posters, charts, illustrations, etc.).

O create Memo cards.

L1 I practice my presentation out loud and make any necessary changes. @
/I:II practice my presentaticon in front of my family or friends and ask for Comments.
Tasks cannot be

modified unless 2]

you are working O 1 do my presentation in front of the class. @
on a blank project.

011 review and evaluate my achievement using the Assessment tab. Ca;j
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Work Management - Project and Assessment Tabs

The tabs Project and Assessment correspond to the first and last task of every project. The Project tab allows you
to identify the requirements and details of your project before you get started, whereas the Assessment tab helps you
reflect on your results and what steps have taken you there. You can customize these tabs by adding or deleting fields.

Presentation Due Date

Presentation title

| Tasks || Project Assessment

Am | satisfied with my presentation?

Did I manage my time properly?| prasentation

Grade {onee I receive it) Presentation title

MY PRESENTATION | Tusks || Frojeet | Assessment

What were the strengths of my g Find v
Finding &4 fopic d

LEMGTH OF PRESENTATION

What were its weaknesses?
EMPORTANT [NSTRIMCTIONS

MY PREPARATION TARGET AUDIENCE

Due Date

Enter information

=7 ahout the project.
/

0

\

The names of existing
fields cannot be modified
unless you are working

What [ would like to do again

INTENTION (=2

= on a blank project.

Information balloons

Things to avoid in the future

Other comments
PERSONAL DBJECTIVES (G2

with related tips

!

NOTE: In the Knowledge Base files, the tabs are slightly different. The Logtab appears instead of the Project
tab, and you can use it to record notions learned in class. In the Assessments tab, you record all the grades
you get on each subject.

v

Determining your intention

IU's Emportant (o delerming what you Wil your
audiencs @ expariencs. What is your intention? Is
it to inform, [0 CONVNCE, [O Provoke @ reaction,
tears or laughter, to frighten, to enchant, 1o stir up

emotions?

Thig % collid Gebarmining your Mtantian ("=

yiu'vl made your decislon, you can chooss and
Groarie your words, sentbaoes, arnd Frages 19

halp you reach your objective

Hop! Study - User's Guide
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Create a New Planner

You can create a new planner at the beginning of your school year (or af the beginning of your term). This planner
will help you manage your time and plan all your projects. It will also serve as a portfolio of your entire school year,
since you can always consult your finished projects and open all related documents.

Change planner settings
(calendar range and subjects).

A

™y M My Plariner

L
i3

L

Plammer Settings

':_; !-_. ID ! 'T:- :3_ Start Date Mama of subjects or courses | cancel |

T FT3 FT0 P T T 2007/8/1 .1Englis|1

& (22 |22 [; |5 |6 [&F End Date ‘Smnd Language

el 2008/6/30 e

”Scimm
s I Geogrephy

e Elistory

Tu-_l_T__ 7 .|P|1ysi¢-ul Education

a1 28 [ N | [ |Moral and Religious Education

. .| | E _ .1T:chmlug:.r Q;’
S e WA o

- Wednesday, August
v

Go to today’s date Navigate the planner Change the time range Change the subjecis
on the planner. by dlicking on dates. included in the planner. listed on your schedule.
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Using the Planner

There are two ways fo record tasks on your planner: specific projects (presentation, research, composition, etc.) and general work on a
subject (read a chapter, do exercises, review your notes, etc.). All general work on the same subject is linked to a knowledge base
that will grow as the year progresses. On the other hand, each project is recorded independently and has its own data file.

Change the dates Add general work Add a project. Three dots indicate general Open the Knowledge Base
for your assignment. on a subject. / work on a subject. for this subject.
| \

aal

o
/

bra

mwlé‘ﬂh@;/@f

PLANNER '~ & =5 xN

15

™ [y

M Marrative Summary The Catcher in the Rye
2 [2 [#
I have ios keep my firsi deafi!

@ History/ Read Chapter 4

Koy m—

You can add

Oral Presentation Monkeys
H [ [2 |2 |4

= comments on
each assignment.

=> Enter the fitle of
each assignment.

il

A diamond marks the deadline for your project. Open a project file.
Green: done Each project has its own
Yellow: to do data file.

Orange: to do first

s ead
! N

Projects are divided into
phases that can be checked
off as they are completed.

A color-coded box
links a project fo a
specific subject.

Hop! Study - User's Guide
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Adding Hyperlinks

You can add hyperlinks to your pages and your planner by selecting the command Add or Change a Hyperlink on the Special menu.

Add a hyperlink Click on a fext field, then select the command Ad(...
Change a hyperlink Put the blinking text cursor on the hyperlink you want to change, then select the command Ad(...
Activate a hyperlink Make sure the field is mot in editing mode, then simply click on the hyperlink.

Add a checkhox to your text.

Add a hyperlink that connects to

Hyperlink

oroherpag i the same documen \ Link working Visible text Cancel Text that will appear
NOTE: You must have already gone &0 & LhackEio 7 Cats dingram > in blue as the active
to the destination page and copied a hyperlink.
word or an image. p o4 Jump to a page
of this document
- Destination of the link de ofth
Open any document -LI272-1;613,257,1; ! 50 : ori ¢
L — and its application | estination page.
Add a hyperlink that < _ | of
connecs fo another file. Open a web page
225 in your browser oK

¥

Use this button to paste the code of the

T

Add o hyperlink that connects For hyperlinks that connect to another

1o 0 webpage. destination page or webpage you have document, this button is replaced by
NOTE: You must have already copied on your clipboard. Choose file...
copied the address.

Visible text
011 wrne whai | want hase]

Lirik working
as & checkbex

o

DuE 1S A pagE
of this decument

any documant
and its application

Open & web pags
i youar rcwener Visible text

E EHMIM

Destination of the link

Link working [(Lancel |

i & checkbax

Jump 1o a page
of this document

R es apocation
o

Hyperdink

Macimiosh
HI:Users:mclauds Desboop  Monkess dod

Open a web page
In your browser

9

Link waorking
as a checkbox

Visible text
s

Jump to a page
of this document

Destination of the link
Open any document hittpr e wekipedia o wiks Mam_Page
and its application

Opan & weh page

in your [ From clipbaard |

2
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Select the command Find on the Edit menu.

or

Text Search

Click on the button Find on the toolbar menu.

Search Panel

Text you want to search @——| sphynx

Search criteria:

* Entire Document
* Current Index

* (urrent Page

* Active Object

/

/| Entire Docurment *

‘ 9 / q:?@% Open the Search Panel.

—%> Start the search.

*\; Sphynx
F:.’I' Sphynx

/ T Sphynx

Search results.

Icons indicate the type of object
where the text appears:

* Text field in a card

* [tem on a fimeline

* Question-and-Answer card

* Diagram box

* Diagram connector

Sphynx images

/F:' the Sphynx cat, as we know it

Click on an element on the list

(?;!}tﬂ a Sphynx kitten in Toronto, C

to open its corresponding page.

Hop! Study - User's Guide
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Toolbar

General tools

[:7 Add a sticky note.

R Toggle between Select Object mode (arrow) or Edit Content mode (A).
32 Apply settings to the selected text (bold, italic, underline).

¥) U Undo or redo previous operations.

Ny 0 & Cut, Copy, Paste and Delete. All four commands can be applied to the content if you are in the Edit mode (A) or
() s .
to objects if you are in the Select mode (arrow).

Workspace tools

E§5J Open Index Panel.
@ - Create a new index.

@ Move pages to another index.

Open the Import an Image dialog box.
Add an empty image box to a card.
Add a text field to a card.

Add a connector to a diagram.

e Copy format from an object or text and apply it

to another. Add a box to a diagram.

S) Open Style Panel and change the appearance

of obiects on the page. Add a connected box to a diagram.

On linear representations, add an item to the timeline or
q Open Search Panel. numerical scale.

% Open the Print dialogue box.

T B B

Planner tools

@ Change calendar range or the subjects that appear
on your schedule.

Add work on a subject.

Add a new project.

% 9]

? Change the dates for your assignment.
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Navigation Bar

“ Go to the Work Management environment.

N pe—

= i
UII . Go to the Content Pages environment.
@ Go to the Testing environment.

@ On the Content Pages environment, go to the previous menu.

@ 22/52 @ On the Content Pages environment, go to the previous or next page.

EE:‘\ On the Content Pages environment, add a new page.

Center the display on an object. Once you select the button, click on an object on the page.

Z

. ﬂ Move within the page. Once you select the button, move your cursor on the page while holding down your mouse button.

€

Center the page display.

_M Increase or decrease the size of your display.

o
% Open Tips balloons
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Most of the commands are standard (Save, Open, Cut, etc.).
Below you will find descriptions of those commands that are specific to this application.

Edit menu

Duplicate

Special menu

Add or Change a Hyperlink
Copy All as Text

Copy All as Image

Copy Style / Paste Style

Adapt Colors for a Projector

Help Menu
Automatically Check for Updates

Update Software Now...

This command is used only to duplicate objects or pages.
Therefore, you must be on select mode (arrow) to be able to use it.

Inserts a hyperlink on a page or on the planner. See page 20 for more details.
Copies all the text on the page so you can paste it onto another document or application.
Copies an image of the page so you can paste it onto another document or application.

These two commands can be used for objects (in select mode)
or for the content of an object (in edit mode).
Changes the colors to optimize the display when you use Hop! Study on a multimedia projector.

When this option is selected, the application checks for updated versions of your software every time
it starts.

This command checks for updated versions of your software and opens a website where you can
download updates.

Hop! Study - User's Guide
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